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1. Introduction 

Gaussian laser beams are the simplest and often the most desirable type of beam provided by a 

laser source, for reasons which also become obvious in the course of this experiment. This experiment 

seeks to investigate the intensity distribution of a laser beam in three-dimensional space. We will 

measure this intensity distribution by a combination of various techniques which will be introduced by 

the instructor. We will learn the use of WINTV for recording pictures from the CCD camera, and ImageJ 

for measuring and analyzing these pictures taken.  

The main experiment will involve first calibrating the CCD camera, and then measure the gamma 

parameter of the camera; measure the laser beam size before and after a lens is used to focus the 

beam. 

 

2. Theory 

In optics, a Gaussian beam is a beam of electromagnetic radiation whose transverse electric field 

and intensity (irradiance) distributions are well approximated by Gaussian functions. The strength of the 

electric field of the simplest mode of a laser is radically symmetric and given by the Gaussian profile 

given in Eq. 1.0. 

 

																																																			���� � ���	�
/��
   ,                            1.0 

where r is the radial distance from the beam axis and � is the characteristic beam radius. Since the 

intensity I is proportional to E2, the radial dependence of the intensity is given by 

                                                  ���� � ���	�
/��
.                                            2.0 

Such a Gaussian beam profile is illustrated in Fig. 1.0, where the distance from the beam axis is 

measured in units of the beam radius	�.  

                                    

Fig.1.0. Gaussian intensity profile of a laser beam [Source: Google Images] 

 

As the laser beam propagates its diameter may change, the beam may either converge or diverge. 

The minimal size spot, where the beam has a radius	�� is called the beam waist. In general, the beam 

radius is  

                                                                 ���� � 	�1 �	� �����	 ,             3.0 
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where  ��	 � �����/� ) and is called the Rayleigh length. In the far field, (i.e. at a distance z >>z0 from 

the minimum at z = 0, the beam radius is given by 

                                                                 ���� � 	 ��
�����  .     4.0 

A measurement of the beam radius as function of z therefore allows the determination of �� for 

known wavelength or, if the waist can be measured, determination of the wavelength. 

 

3. Experimental Details 

3.1 Equipment Utilized 

All equipment used is according to standard and as recommended by the instructor. These included: 

A 640x480 pixel CCD camera (see Fig. 3.1), 2.54mm flat washer ring, ImageJ software for measuring and 

analyzing pictures taken, TV monitor, WinTV7 for taking snapshots from the CCD camera, lens tube, 

black cloth, ND filters, Print scale, and a He-Ne Laser, clamps for holding the optical apparatus in place. A 

flash light came in handy during the times when surrounding lighting will be turned off to achieve better 

results. 

 

 

Fig. 3.1 The CCD camera (Source: AMO Lab at Dept. of Physics, Western Illinois University) 

 

3.2  Procedure 

We first examined the basic parts of the experimental setup, learning through the instructor, 

functions of these parts. Ample time was spent on discussing the functioning of the CCD camera and 

how this is interfaced with the TV monitor. We also took a basic tour of the ImageJ software looking at 

the various methods for analyzing the pictures. ImageJ has a detailed manual which can be used for 

learning the functioning of the software. However, we only needed a few steps which involve opening 

(on the File menu, choose open, and browse to the folder which contains the file to be uploaded) the 

photo, and selecting, using the select tool, a rectangular area in the image which is to be projected. Next 

step is to click plot profile option on the Analyze menu (see Fig. 4.10 in section 4.0 for a sample plot 

produced). To change the axis of measurement, say to ‘vertical’, click options -> plot profile options on 

the Edit menu, and then check the vertical profile option in the pop-up box. This was a lot to remember 
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in the first few tries, but it soon becomes easy after a few steps. We assigned Stewart Ferrell to take the 

snap shots and generate the plot profiles so that other members can concentrate on the remaining 

tasks.   

After this initial introduction, we then went on to calibrate the CCD camera. Our goal at this point is 

to take a picture of the 2.54 mm ring washer and use the analyzed photo to calibrate the camera. 

However, the photo was already taken at the time of this experiment, so we just went ahead with the 

analysis. Fig. 3.20 shows a picture of the flat ring washer that was measured. The pixel sizes for both the 

x and y axes were calibrated. Results are shown in section 4.0. 

  

 

Fig. 3.20. A Picture of the 2.54 mm flat ring washer 

 Measuring the gamma parameter of the CCD Camera 

First, we adjusted the lens of the CCD camera until a fine image of the surrounding environment or 

object in focus can be seen on the TV monitor. The camera was then focused on the print scale, and 

adjusted again. In order to obtain an even clear image for better results, we attached a lens tube to the 

camera and then covered both the print scale and camera with a black cloth. This essentially ensures 

that no ambient or reflected light is recorded by the camera. A picture of the print scale is then taken as 

seen in Fig. 3.32 below.  

 

Fig. 3.2 A picture of the print scale. 

 Again, using the procedures described earlier, ImageJ was used analyze and then to measure the 

relative intensity. In this case, we selected a rectangular area in each sector of the print scale and 

analyzed these sectors separately to obtain a series of results (see section 4.0 for these). 
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The gamma parameter was then found using	���� �  ��!"�#. The slope of the plot of ���� −	�!"	in 

logarithmic scale as in Eq.  3.1 below, thus gives the gamma factor.  

    Log	I)*+ � Log	A � 	γLog	I./                                                   3.1 

In the above, �!" is the obtained from the transmutivity of the neutral density filter sectors of the 

print scale, while ���� is the relative intensity recorded from analyzing the picture. 

Measuring the laser beam size before the lens 

At this point we experimented with a couple of the ND filters which were used to attenuate the 

intensity of the camera before the laser hit the camera. First we tried with filter with ND=5 and worked 

all the way down to about ND=3.0 for the most convenient results. An image of the laser beam was 

taken as seen in Fig 3.23. and this was again analyzed accordingly. We took a measurement of plot 

analysis both along the x-axis and y-axis. Then a Gaussian curve fitting was done in ImageJ (see Fig. 

3.24). As noted in the laboratory instructions, the parameter 2d in the curve fitting equation shown on 

the plot is the beam radius. Results are shown in section 4.0 

 

 

Fig.3.22. Laser beam picture before lens 

 

Fig. 3.2.3. Gaussian fit of the projection of laser beam before lens (x-direction) 
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Fig. 3.24. Gaussian fit of the projection of laser beam before lens (y-direction) 

 

Measuring the laser beam size of the focused laser beam 

We removed the CCD camera and placed a 69mm lens. Then the camera was again scanned along 

the z direction, taking the pictures and analyzing as before. In all, 16 pictures was taken and analyzed. 

The results section shows these results and the beam distribution curve.  Table 4.10 gives the results 

obtained. 

 

4. Results and Discussions 

Fig. 4.10 and Fig. 4.11 show the projection of the washer along the x and y axis respectively. 

 

Fig. 4.10 the projection of washer along x axis 
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Fig. 4.10 the projection of washer along y axis 

The pixel sizes along the x or y axis were then obtained by dividing the real diameter of the ring hole 

by the pixel distance measured using the profile plots above. 

 Diameter of hole = 2540μm 

We obtained, for the x-profile:  pixel distance = 345; for the y-profile: pixel distance = 334 

Therefore, on x-axis  Pixel	Size � 	 �78�9:;87 � 7.36	@A   

Similarly, on y-axis  Pixel	Size � 	 �78�BC;;8 � 7.60	@A 

The average pixel size is thus: 7.48 @A 

 

Measuring the gamma factor 

Here is the data obtained to measure the gamma factor. 

Inpu

t beam 

(Iin) 

Mean 

(Iout) 

Log 

Iin 

Log 

Iout 

13.3 

68.2

13 

1.123

852 

1.833

867 

19 

82.2

73 

1.278

754 

1.915

257 

28 

113.

719 

1.447

158 

2.055

833 

45 

156.

921 

1.653

213 

2.195

681 

63 

187.

704 

1.799

341 

2.273

474 

88 

230.

522 

1.944

483 

2.362

712 

 

Table 4.10. Values of �!" and ���� measured 
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Fig.4.10. Plot of �!" against �!" showing equation of graph 

 

The gamma factor, from the slope of the graph above, turns out to be:  E = 0.6586 

 

Measuring the laser beam size before the lens 

From the Gaussian plots, we obtained, 

 

ωG � 2�31	pixel × 7.5�μm
pixel

= 465	μm 

ωO =
2�35	pixel × 7.5�μm

pixel
= 525	μm 

Therefore, 

 

ω =	PωGωO = 	√465 × 525 = 494	μm 

And by, 

ωSTUV 		= ωSTUV/Pγ 

 

ωSTUV 		= 494	 × √0.6586 = 400	μm 

 

Measuring the laser beam size of the focused laser beam 

y = 0.6586x + 1.0912
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An estimation of ω� is done using equation (19) from the laboratory manual as follows: 

 

ω� �
f	λ

πω.
�
69000μm	 J 0.633μm

π	 J 400	μm
� 34.74μm 

The Rayleigh range is thus, 

z[ �
πω�

�

λ
�
π	 J �35μm��

0.633	μm
� 6.08mm 

 

The \� factor is, 

M� �
πω�

�

z[λ
�

π	 J �35μm��

6082	 J 0.633	μm
	� 1.00002	 ^ 1.0 

 

Z(m

m) 

 dx(Pixel) dy(pixel) 

7 4.17 4.34 

8 3.8 4 

9 3.44 3.59 

10 3.27 3.33 

11 3.04 3.12 

12 2.85 2.96 

13 2.65 2.65 

14 2.57 2.56 

15 2.45 2.44 

16 2.61 2.64 

17 2.96 2.96 

18 3.16 3.28 

19 3.33 3.49 

20 3.85 3.76 

21 3.84 3.91 

22 4 4.15 

 

Table 4.10 Results obtained when the laser beam size was measured 
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As expected, a hyperbolic plot is obtained showing the relationship between the beam radius and 

the propagation direction, as seen in Fig. 4.10 

 

p 

Fig. 4.10. The Gaussian beam radius along the beam propagation direction 

 

5. Conclusions 

This experiment showed to be very enlightening as new concepts and methodology were 

introduced.  In the end, we were able to obtain the expected hyperbolic distribution of the laser beam, 

by plotting the beam radius along the propagation direction, meaning that our methods for conducting 

the experiment, notwithstanding inaccuracies in observation, are acceptable. We can say that the 

experiment went well. 

In addition, the result obtained for the \� factor is very interesting as it shows that the laser source 

is of high quality. 

6. References 

[1] Laboratory Manual [PHYS 570 Gaussian Laser Beams by Pengqian Wang (PhD)] 

 

7. Additional questions 

7.1 We cannot add the ND filter after the lens because this will shift the focal point and affect the 

results obtained. 

7.2  Derivation of equations 

 Here we derive equation (24). From equation (21) in the laboratory manual, 
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Let us set 	A � I0	 ω02
ωin2�z�  so that Eq(1.0) becomes the form, 

                                         I./ � A	e	

�c
de
	�
f`a
�g�                                                                           2.0 

  I)*+ and I./	are thus related by, 

																																										I)*+ � AI./i       , where  γ is the gamma parameter              3.0 

Therefore, we can write, 

I)*+ � Ae�
j
�c
d	e
�
f`a
�g� �k

  = Ae�
j
�c
d	e
�
f`a
�g�/k �   =	Ae

� j
�c
d	e
�
�f`a�g�/Pk�


�
  = Ae

�j
�c

d	e
�

f�
�g�
�

   

This implies, 

�ω��� = �ω./	/Pγ�� 

Or, 	

ωSTUV 		= ωSTUV/Pγ 

End of Proof. 


